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Chapter 5 

The Integrated Development 
Environment

Before you can start building dashboards and applications with SAP 

Lumira, designer edition, you should know your way around the devel-

opment environment. This chapter introduces the SAP Lumira, 

designer edition workspace and its elements.

SAP Lumira, designer edition allows developers to create interactive applications and

dashboards. With its integrated development environment (IDE), the developer can

create a user interface (UI) with components from a predefined library, configure the

properties of these components, and set up data connections with source systems.

Finally, the application can be published to the SAP BusinessObjects Business Intelli-

gence (BI) platform. SAP Lumira, designer edition is fully what you see is what you get

(WYSIWYG), which eases the development process.

Figure 5.1  Integrated Development Environment
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Figure 5.1 shows the SAP Lumira, designer edition development environment, includ-

ing the menus, toolbar, and the Layout Editor. The Documents, Components, Outline,

Properties, Additional Properties, Error Log, Search Results, and Script Problems tabs

are also visible. This chapter will introduce you to all these features in the SAP

Lumira, designer edition IDE and help you get familiar with the menus, toolbars, and

views available in this tool.

5.1    Menu

The menu bar is located at the top of the SAP Lumira, designer edition window and

contains eight dropdown menus. We’ll discuss each of these menus and their items

next.

5.1.1    File

The File menu has the most options in SAP Lumira, designer edition. This menu

allows you to create, open, save, or execute an SAP Lumira, designer edition applica-

tion. All the options in the File menu are shown in Figure 5.2.

Figure 5.2  File Menu
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Create Document, Open Application or Composite, and Open Recent

An SAP Lumira document is a collection of applications, composites, and MIME

repository items. Before you can create a dashboard application, you’ll have to create

an SAP Lumira document. The first time you create an application, the document will

be created automatically. After the first time, you’ll open the File menu, right-click on

the Document Explorer (Figure 5.3), or use the keyboard shortcut (Ctrl)+(N).

Figure 5.3  Documents Tab

When you select the option to create a new document, a prompt window will open

where you can name the document and choose an existing template, as shown in

Figure 5.4. When you are connected to the SAP BusinessObjects BI platform, you’ll

have to specify a folder location where you want to store your SAP Lumira document.

Your new document will appear in the Document Explorer along with a standard

application called “APPLICATION”. You can choose from five standard templates and

one ready to run template.

The Open Application or Composite option lets you open an existing application or

composite stored on your PC or on the SAP BusinessObjects BI server. Instead of

using this menu, you can also double-click on the application or composite in the

Documents tab (Figure 5.3).
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Figure 5.4  Creating a New Document

The Open Recent menu item is a quick way to return to recently opened SAP Lumira

applications or composites.

Close, Close All, and Delete

The Close option, accessible by shortcut (Ctrl)+(W), closes the currently opened

application or composite. The Close All option, accessible by the shortcut (Ctrl)+

(Shift)+(W), closes all opened applications or composites.

The Delete menu option deletes the currently opened application or composite.

Save, Save As…, and Save All

If you want to keep the changes you’ve made to an application, you can use the Save

command to overwrite the original saved file with the newer version. The keyboard

shortcut for this command is (Ctrl)+(S).

If you don’t want to overwrite your original saved file, you should use the Save As…

option. You’ll be prompted for a new (unique) name, and then, you can choose to

save the application in the same SAP Lumira document, or you can choose another

Target Document (Figure 5.5).
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When you’re working with multiple applications or composites at the same time, the

Save All command can save changes for all these applications at once. The keyboard

shortcut for this option is (Ctrl)+(Shift)+(S).

Add Data Source… and Show Prompts

The Add Data Source… option lets you add a data source to an open application or

composite. You can also right-click on the Data Sources folder and choose Add Data

Source… from the context menu (Figure 5.6). When you select this option, a new

prompt window will open (Figure 5.7) where you can choose an existing connection.

When working on a document on the SAP BusinessObjects BI platform, the connec-

tion defined on the SAP BusinessObjects BI platform will be available. When working

on a local document, the connection in your SAP GUI will be shown. If you know the

exact technical name of the query you want to use, you can add the technical name

as well. Otherwise, you’ll have to browse to a specific query (Figure 5.8) or use the

search function to search for your query.

Figure 5.6  Outline Tab
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As shown in Figure 5.7, the data source will be assigned a default alias name starting

with DS_1. You can change this name if you wish. When you are done, just click OK,

and the data source will appear in the outline view in the Data Sources folder. You can

use the data sources in this folder and connect them with other components in your

application.

Figure 5.7  Adding a Data Source

Figure 5.8  Selecting a Query
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Tip

To quickly assign a data source to a component that has already been added to the

application, you can drag and drop the data source on top of either the item in the

outline view or the component in the layout editor.

The Show Prompts menu item displays the prompts that were initially inserted when

you added a data source with prompts to your application. You can also change the

prompt values (Figure 5.9).

Figure 5.9  Prompts Screen

Execute Locally

The Execute Locally option lets you run your application using your PC as a server.

Using this option lets you skip the SAP BusinessObjects BI platform. The advantage

with running the application locally is that you can make changes to your application

and run the modified application locally without having to save the application.

Reload

Sometimes, you may need to reload your application, for example, when you’ve

made changes to one of the data sources and want these changes to be displayed in

your application. You can use the Reload menu item or use the keyboard shortcut

(F5).



5 The Integrated Development Environment

134

Log Off and Restart, Exit

The Log Off and Restart option lets you disconnect from the SAP BusinessObjects BI

platform (if you are connected) and restart SAP Lumira, designer edition. The Exit

option closes SAP Lumira, designer edition. For both options, you’ll have the choice

to save your work if you did not already do so.

5.1.2    Planning

The Planning menu contains two options: Add Planning Function and Add Planning

Sequence (shown in Figure 5.10). Planning functions and planning sequences are SAP

Business Warehouse (SAP BW) objects that can be used in applications that use SAP

BW Integrated Planning (SAP BW-IP). Both of these objects are modeled in SAP BW.

Figure 5.10  Planning Menu

With SAP BW-IP, users can enter plan values into an application that can be then

saved back into the InfoCube in SAP BW. Entering plan values can sometimes be a lot

of work, but instead of manually entering the values in every single data cell, users

can define some logic for this task. For instance, let’s say the logic for planned values

might be to use last year’s actuals increased by 5%. A planning function can be cre-

ated to achieve this goal. Other planning functions might be to delete the data or to

write to save the data. A planning sequence is a series of planning functions executed

one after the other. We’ll discuss planning sequences in more detail in Chapter 9.

5.1.3    Edit

The Edit menu (Figure 5.11) provides the basic productivity features common in desk-

top applications. You can quickly undo or redo a certain operation or copy and paste

an object.
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Figure 5.11  Edit Menu

Undo and Redo

You can use the Undo option to reverse an action you performed. For example, if you

just created a crosstab component but decide you do not need it, you can easily go

back to the state of your application before the component was created. The key-

board shortcut for Undo is (Ctrl)+(Z).

The Undo option also shows what action will be undone. As shown in Figure 5.11, the

Undo action will undo a change that was made to a crosstab, whereas in Figure 5.12 a

set visible action will be undone.

Figure 5.12  Undo Set Visible

If you used the Undo feature but still want to use the change, you can use Redo to

reverse the undo action. The keyboard shortcut for Redo is (Ctrl)+(Y).



5 The Integrated Development Environment

136

In SAP Lumira, designer edition, you can go back and forth across multiple steps with

these options.

Copy and Paste

Some other well-known features are Copy and Paste. When you use the Copy option

on a selected component, the component will be stored in your system’s clipboard.

You can use the Paste option to paste the component into the desired location.

You can use these commands on multiple selected components at the same time.

The keyboard shortcuts are (Ctrl)+(C) for Copy and (Ctrl)+(V) for Paste.

Delete

The Delete command erases the selected component or components from the appli-

cation. The keyboard shortcut for this action is (Del).

5.1.4    Layout

The Layout menu (Figure 5.13) is all about positioning components within an SAP

Lumira, designer edition application.

Figure 5.13  Layout Menu

Align

With the four Align commands, you can position two or more components on the

same left, right, top, or bottom edge. To align components, select two or more com-

ponents in the outline view (Section 5.3.3) by holding (Ctrl) or (Shift) while clicking.

Next, select the Align command for the alignment that you want to execute.
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SAP Lumira, designer edition uses the outermost component as the leading place-

holder. Let’s say you have three components in your application: component A on

the left of the application, component B in the middle, and component C on the right.

If you select these three components and choose the Align Left command, compo-

nents B and C will be aligned with the left side of component A because that compo-

nent provides the outermost position for the Align Left command. If you choose the

Align Right command, components A and B will be aligned with the right side of com-

ponent C.

Distribute

With the Distribute Horizontally and Distribute Vertically options, a set of three or

more selected components can be spaced evenly. The two outer components remain

in position, but the components lying in between are arranged such that the distance

between the center point of each component is the same.

Maximize Component

The Maximize Component command enlarges a component to its maximum size.

When you use this option, the layout properties of the component will be set, as

shown in Figure 5.14, with “0” for the margins and “auto” for the width and height.

Figure 5.14  Layout Properties after Using the Maximize Component Command

The Show Grid Lines option adds gridlines to the canvas of your application (Figure

5.15), which you can use to better position components. The gridlines are only visible

while you design, so when you execute your application, you don’t have to worry

about the gridlines showing up.
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Figure 5.15  Show Gridlines

5.1.5    Search

The Search menu (Figure 5.16) brings some very powerful developer features to SAP

Lumira, designer edition—Search... (to search the application) and Find References—

which will come in handy when working with more complex applications.

Figure 5.16  Search Menu
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Search...

With the Search... option, you can search every text string that is used throughout

the complete application—whether that string is a part of code, a component name,

or a property value. The results box displays the search results while you’re typing.

You can make the search case-sensitive by selecting this option after clicking the

Options >> button. You can also specify that you want to search through the hidden

components.

As shown in Figure 5.17, ten matches are available when searching for the string

“false.” The results are grouped by component, showing the corresponding compo-

nent icon and its name.

You can double-click a component or property to select it. If you double-click a script

or a CSS style, its editor opens instantly.

Figure 5.17  Search Application

Clicking the Keep Results button closes the Search Application window, and the

search results appear in the Search Results tab (see Figure 5.18). You can also press

(Enter) to do this.
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Figure 5.18  Search Results View

The keyboard shortcut for Search Application is (Ctrl)+(Shift)+(F).

Find References

The Find References option lets you easily find other components and the scripts that

are linked to the currently selected component. The results are displayed in the

Search Results tab (Figure 5.19). The keyboard shortcut for this command is

(Ctrl)+(Shift)+(F).

As with the Search Application results, you can double-click a component to select it.

Double-clicking a script or a CSS style will open its editor.

Figure 5.19  Find References

5.1.6    View

The View menu enables you to show or hide the tabs that are present in SAP Lumira,

designer edition (Figure 5.20). We’ll discuss these tabs in depth in Section 5.3, so we’ll

only briefly mention the key purpose of each tab, as follows:
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Figure 5.20  Tabs in the View Menu

� Documents 

The Documents tab displays all the SAP Lumira documents, applications, compos-

ites, and MIME repository objects that you have worked on. If you have a connec-

tion to the SAP BI platform, this view will be divided into two parts: one for local

documents and another for documents stored online.

� Components 

The Components tab lists all the components you can use to create a UI in the Lay-

out Editor for your SAP Lumira, designer edition application.

� Outline 

The Outline tab lists all the data sources, planning objects, layout components, and

technical components currently used in the Layout Editor of the SAP Lumira,

designer edition application.

� Properties 

The Properties tab shows the properties of the SAP Lumira, designer edition appli-

cation or one or more selected components.

� Additional Properties 

Some components, such as chart and geo map components, have additional prop-

erties to further configure the look and features of the component. The Additional

Properties tab displays these settings.

� Script Problems 

The Script Problems tab shows script errors if any exist in the application.

� Search Results 

The Search Results tab lists the search results from the Search... command in the

Search menu.
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� Error Log 

The Error Log tab lists general errors in the SAP Lumira, designer edition applica-

tion itself.

� Reset Layout 

The Reset Layout command rearranges the tabs around the Layout Editor. All tabs

are shown except the Search Results tab and the Error Log.

5.1.7    Tools

The Tools menu has four options: Install Extension to Lumira Designer, Install Visua-

lization SDK Extension, Platform Extensions, and Preferences (Figure 5.21).

Figure 5.21  Tools Menu

Although many standard components are available in SAP Lumira, designer edition,

you can also use components developed using the SAP Lumira, designer edition soft-

ware development kit (SDK). These components are installed using the Install Exten-

sion to Lumira Designer menu item. A window will pop up asking for the path to the

SDK (Figure 5.22), which can be a local path or a URL. When you click on the Get Part-

ner Extensions link, you’ll be guided to a catalog of third-party extensions you can

use. Some are even free! The URL to the partner extension is https://www.sapappcen-

ter.com/productLines/11#!/list/page/1.

Figure 5.22  Installing Extensions

143

5.1 Menu

5

The Install Visualization SDK extension option also lets you install a third-party chart

component. The difference is that SAP Lumira, designer edition treats this extension

like a regular chart component. In the properties of any chart component, you’ll have

the option of switching between chart types. When a third-party chart is installed as

a visualization extension, this chart will also be available in the list of selectable

charts.

In the Preferences menu (Figure 5.23), you can review and change the settings for SAP

Lumira, designer edition.

Figure 5.23  SAP Lumira, Designer Edition Preferences

On the left side of the window, you can choose between the following menus:

� Application Design

– Application Templates
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– Backend Connections

– Network Connections

– Support Settings

� Scripting

– Syntax Coloring

– Templates

Because the bulk of the functionality in the Tools menu is within this Preferences

option, we’ll devote some time to these preferences here.

Application Design

First, let’s take a look at the Application Design settings.

In the General area, you can change the preferred startup mode for SAP Lumira,

designer edition. You can choose between the following options:

� SAP Lumira Documents

� Local mode (Legacy)

� SAP BusinessObjects BI Platform (Legacy)

The Undo History Size setting determines how many changes can be undone by using

the Undo command from the Edit menu.

In the Embedded Web Server area, define the Network Port for the web server embed-

ded in SAP Lumira, designer edition to execute applications locally. If you use the

default value of “0,” SAP Lumira, designer edition will assign a network port.

In the Application Preview area, you can define which language settings to use when

executing an application: either BI Platform User Settings, which are the language

settings in the SAP BusinessObjects BI Launchpad, or Web Browser, which are the lan-

guage settings that defined in the web browser. The selected language is used for

message texts and tooltips and for determining the correct formatting of numbers,

dates, and times.

The Application Recovery area gives you the option to have SAP Lumira, designer edi-

tion create a recovery copy of your application. To enable this functionality, select

the checkbox and define the time interval between each copy.

The Member Selection area allows you to define how many members of a dimension

are shown when using the Script Editor.
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As shown in Figure 5.24, the Content Assistance feature, accessible by shortcut

(Ctrl)+(Space), has been used to show a list of members for the 0CALMONTH

dimension. This list is shown because it consists of fewer than 20 members. You can

change this value by editing the Maximum number of members to fetch from

backend in Content Assistance number setting.

Figure 5.24  Fetching Dimension Members

In the example shown in Figure 5.25, we’ve changed the maximum number of mem-

bers to be fetched to 5. Now, when you want to select a certain member, a warning

message will be shown, and you’ll have to use the search functionality to search for

the desired member.

Finally, you can select the Display warnings for manually entered invalid values set-

ting to let SAP Lumira, designer edition display warnings in the Script Editor when

nonexistent values are entered.
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Figure 5.25  Maximum Number of Members Exceeded

Sometimes you’ll run into performance issues, especially when you use many com-

plex scripts in your application. You can select the option Disable backend validation

and Disable Inplace Help. The first option skips master data validation. For instance,

if you want to use a script to filter a certain dimension, no master data check will

occur if this dimension is valid. When checked, the second option won’t display infor-

mation about the methods you’re using in your script.

If your application uses an SAP BEx query with input variables as a data source, you

can use the Show Prompts command from the Application menu to select the

prompt values. If the Use cached prompt values for local execution option is selected

in the Prompt Handling section of the Application Design screen, the application will

use the prompt values that are already set in SAP Lumira, designer edition when exe-

cuting the application locally.

You can clear these prompt values with the Clear Prompt Value Cache button. The

dialog box gives you the option to choose the applications for which the cache should

be emptied (Figure 5.26).
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Figure 5.26  Clear Prompt Value Cache

Application Templates

When you are in one of the legacy modes, you can create your own application tem-

plates and even share these templates with other developers. When you’ve devel-

oped an application, you want to use as template, select the Export as Template

option from the Application menu. Give the template a name and a description and

then save this template somewhere on your local or shared drive (Figure 5.27).

Figure 5.27  Creating and Exporting a Template

You’ll notice that, the next time you create a new application, the template will be

available to be chosen in the New Application screen (Figure 5.28).
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Figure 5.28  New Application Screen

In addition, when you look at the Application Templates option in the Preference

menu, you’ll see the name and path of the template (Figure 5.29).

Figure 5.29  Application Template Settings
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Backend Connections

Now, refer back to the Preferences screen shown in Figure 5.23. Click on Backend

Connections under Application Templates. This area will display the available back-

end connections, which you can use to create data sources. The contents of this area

can differ depending on the startup mode you used. When the preferred startup

mode is Lumira Documents, you’ll be able to create a connection to a local SAP HANA

ODBC driver connection. When connected locally, you should be able to see all the

connections defined in your SAP GUI. When connected via the SAP BusinessObjects

BI platform (legacy mode), you’ll be able to see all the connections that are defined in

the Central Management Console (CMC).

Network Connections

On the Network Connections tab, shown in Figure 5.30, you can configure the system

to use a proxy server. Proxy servers act as a connection between the client browser

and application and can be used to increase the performance and security of an appli-

cation.

Figure 5.30  Network Connections
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When the Active Provider is set on Native, the proxy settings defined in the operating

system are used. When the Active Provider is set to Direct, all connections are opened

without the use of a proxy server. When the Active Provider is set to Manual, the set-

tings defined in Eclipse are used.

Support Settings

Now, click the Support Settings option. The options in Support Settings can provide

help if problems or errors arise (Figure 5.31).

Figure 5.31  Support Settings

With the Log Level setting, you can define the level of detail to be displayed in logs

shown in the Error Log tab.

To generate a trace file to be used for in-depth analysis of the activities performed in

SAP Lumira, designer edition and in the executed application, you can select the

Activate Runtime Trace checkbox. The trace file is stored in the following location: C:\

Users\<User>\LumiraDesigner-workspace\.metadata\.plugins\com.sap.ip.bi.zen\logs.
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You can also record SAP Java Connector (SAP JCo) traces by checking the Activate SAP

JCo Trace setting. The trace files can be collected with the Collect Support Information

option (Section 5.1.8).

SAP Java Connector (SAP JCo)

More information on SAP JCo and SAP JCo traces is available at http://wiki.sdn.

sap.com/wiki/display/SI/Java+Connectivity.

Scripting

In the Scripting section, you can adjust some settings that support coding activities.

Syntax Coloring

With Syntax Coloring (Figure 5.32), you can adjust the styling of scripts to make the

code easier to read.

Figure 5.32  Syntax Coloring

Templates

Templates for scripts (Figure 5.33) can be used in the Script Editor to generate a pre-

defined code template. In Chapter 8, Section 8.2.2, we’ll talk more about these script

templates.
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Figure 5.33  Script Templates

5.1.8    Help

As the final item in the menu bar, the Help menu (Figure 5.34) provides several sup-

port options for SAP Lumira, designer edition, as well as some more detailed informa-

tion about your current SAP Lumira, designer edition installation.

Figure 5.34  Help Menu

Welcome

The Welcome option shows the Welcome page that you also see when you start SAP

Lumira, designer edition (Figure 5.35). The Welcome page consists of four sections:

� Getting Started 

This area provides a number of links to introductory video tutorials. The More link

redirects you to SAP’s official product tutorial website for SAP Lumira, designer

edition.

153

5.1 Menu

5

� Create New 

The button in this area closes the Welcome page and creates a new SAP Lumira,

designer edition application.

� Recently-Used Analysis Applications 

The five most recently used SAP Lumira, designer edition applications are listed in

this section.

� Useful Links 

Some links to the SAP website are listed in this section.

As you might have noticed, this Welcome page doesn’t bring any real added value to

SAP Lumira, designer edition, because most of its features are also available else-

where. Luckily, in the bottom-left corner, you can deselect the checkbox to disable

showing this page at each startup of SAP Lumira, designer edition.

Figure 5.35  Welcome Page

Help Contents

The Help Contents option provides the default guide for SAP Lumira, designer edi-

tion, created by SAP.

Collect Support Information

When you select the Collect Support Information option, a ZIP file is created that

includes several configuration settings and logs.
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About SAP Lumira, Designer Edition

You can use the About option to check the installation and versioning details of your

SAP Lumira, designer edition setup (Figure 5.36). When you click on the Installation

Details button, a new window will open with some additional information about the

installed components.

Figure 5.36  About SAP Lumira, Designer Edition

5.2    Toolbar

Positioned just below the menu bar, the toolbar includes many commands that are

also available in the menus; however, the toolbar just makes these commands a bit

easier and faster to access (Figure 5.37).

Figure 5.37  SAP Lumira, Designer Edition Toolbar

You can use simply clicking on a toolbar button to execute the command. As with the

commands from the menus, depending on the component or components you’ve

currently selected, some of the buttons are enabled, and some are disabled. For
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example, the Alignment buttons are only active when two or more components are

selected.

The toolbar is divided into eight command groups. Each new group starts with a ver-

tical line of dots. You can rearrange these command groups by selecting the vertical

line of dots and dragging the group to the desired position on the toolbar.

The commands that we have not mentioned yet are the Send Local version to Mobile

Device and SEND BI Platform Version to Mobile Device command (see Figure 5.38).

These functions generate a QR code (quick response code) of the URL of the SAP

Lumira, designer edition application (Figure 5.39). This QR code can be read by a QR

code scanner application on a mobile device. Free applications with this functionality

are widely available in app stores. After scanning the QR code, you can run the appli-

cation URL in a browser on the mobile device to execute the SAP Lumira, designer

edition application.

Figure 5.38  Send to Mobile Device Toolbar Command

Figure 5.39  Generated QR Code
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Table 5.1 lists all the toolbar buttons with a short description of their commands.

Toolbar button Command Description

Create a new SAP Lumira, designer edition document.

Open an existing application.

Save the current application.

Add a new data source to this application.

Add a planning function to the application.

Add a planning sequence to the application.

Undo an operation.

Redo an operation.

Execute the application locally.

Left-align two or more selected components.

Right-align two or more selected components.

Top-align two or more selected components.

Bottom-align two or more selected components.

Distribute three or more selected components horizontally.

Distribute three or more selected components vertically.

Maximize the size of a selected component.

Show grid lines on your canvas.

Open the CSS Style Editor (see Chapter 10 for more details).

Search the application.

Find references to a selected component.

Show prompts.

Reload the application.

Table 5.1  Toolbar Buttons and Their Commands
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5.3    Layout Editor

The Layout Editor is the central area of SAP Lumira, designer edition. Functioning as

the visual representation of an application, the Layout Editor is the place to design

your applications in a WYSIWYG format.

If you make changes to your application, an asterisk (*) will be placed in front of the

technical name shown on top of the Layout Editor. This asterisk indicates that the

current version of the application hasn’t been saved yet.

The Layout Editor is affected by what tabs you select in the View menu, which we

briefly introduced in Section 5.1.6. Now, we’ll go into a lot more detail about what

each of these tabs means for you.

5.3.1    Documents Tab

The Document Explorer (Figure 5.40) shows all the documents that you are working

on. The documents are divided into documents stored on the SAP BusinessObjects BI

platform and documents stored on your local PC.

Figure 5.40  Document Explorer

If you’re working on an SAP BusinessObjects BI platform document, you’ll have the

following options when calling up the context menu (Figure 5.41):
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� Create Document 

Creates a new document on the SAP BusinessObjects BI platform.

� Download documents 

Downloads the document that you have selected to your PC.

� Synchronize with BI platform 

Changes you make to a document must always be synchronized first before they

are visible on the SAP BusinessObjects BI platform.

� Close all documents 

Closes all documents.

Figure 5.41  Context Menu: SAP BusinessObjects BI Platform Documents

If you’re working on local documents, the context menu will look like Figure 5.42. The

difference, when compared to a SAP BusinessObjects BI platform document context

menu, is that you won’t have the synchronize option. However, you do have an extra

Refresh option which checks your local repository folder for new documents.

Figure 5.42  Context Menu: Local Documents
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When you right-click on a document in the Document Explorer, whether in Local

Documents or in BI Platform Documents, you can call up the context menu to create

a new application, for instance. Figure 5.43 shows the context menu for BI Platform

Documents, and Figure 5.44 shows the context menu for Local Documents. The most

important menu items are Create Application... and Create Composite.... If you’re

working on an SAP BusinessObjects BI platform document, you’ll have additional

options to synchronize the document you are working on, execute the application

locally, execute on the SAP BusinessObjects BI platform, or delete the document from

the platform. If you’re working on a local document, the extra option that you’ll have

is to upload your document to the SAP BusinessObjects BI platform.

Figure 5.43  Context Menu: SAP Business-

Objects BI Platform Documents

Figure 5.44  Context Menu: Local 

Documents

5.3.2    Components Tab

The Components tab (Figure 5.45) houses all the visual building blocks to create an

application, including an interactive UI. To add a component to an application, just

drag and drop the component from the Components tab into the Layout Editor.
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Figure 5.45  Components Tab

The components are grouped in five categories:

� Table Components

These components can either be a regular crosstab, a scorecard, or a spreadsheet.

� Chart Components 

Chart components are charts or maps and related components that can be used to

configure these charts.

� Filter Components 

These components are regular filter components you can use as filters in your

applications.
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� Basic Components 

These components can be used to create more advanced filters and interactivity,

as well as to display images and texts.

� Container Components 

These components are used to define the framework of an application by grouping

and structuring the other components.

5.3.3    Outline Tab

The Outline tab provides a structured overview of all the components and data

sources used in the application. As shown in Figure 5.46, five folders can be found

under the top application level: Global Variables, Data Sources, Planning Objects,

Layout, and Technical Components.

Figure 5.46  Outline Tab
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All the global variables that you create in your application will be grouped in the

Global Variables folder. As the name indicates, all data sources will be displayed in the

Data Sources folder. In the Planning Objects folder, you can add planning functions

and planning sequences to the application. Components that can be seen on screen

are shown in the Layout folder, in a structured way. The example in Figure 5.46 shows

a tabstrip component with two tabs. As a container component, other components

can be placed within the tabstrip component. Tab 1 contains a grid layout compo-

nent, consisting of six cells that, in turn, each have a chart component. Tab 2 is empty.

In the Technical Components folder, you can define technical objects such as Backend

Connections, Context Menus, Global Script Objects, PDF Objects, and Text Pool

Objects (Figure 5.47).

Figure 5.47  Technical Components

Not only does the Outline tab give you a clear overview of the application and its

components and data sources, but you can also use the Outline tab to select and rear-

range these items. By holding (Ctrl) and clicking, you can select multiple items, and
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by holding (Shift) and clicking, you can select a range of items. With the search box

on top of the Outline tab, you can quickly look for an item. The search results will

appear as soon as you start typing.

When you right-click an item, its context menu is shown, providing a number of

quick commands. These commands differ according to the type and number of items

selected. The options for Copy, Paste, Rename, Delete, and Find References are avail-

able for all items.

For the data source items here, the options Edit Initial View and Reset Initial View are

also available (Figure 5.48). The initial view of a data source represents the formatting

of the data source. The Reset Initial View command sets the output of a data source

back to its original state by eliminating all the changes you made using the Edit Initial

View option.

Figure 5.48  Context Menu for Data Sources

You can change the initial view of a data source with the Edit Initial View option,

which brings you to the screen shown in Figure 5.49. This screen is divided into the

following four areas:

� The available dimensions and measures are placed on the left, including their

attributes and hierarchies (when available). To add an attribute, right-click the

attribute and select Add from the context menu. An attribute is only visible in the

result set when its dimension is also added to the columns or rows. If a dimension

has a hierarchy, you can go to the context menu of this hierarchy to activate it,

deactivate it, and set its expansion level.

� At the bottom-left side of the screen, you’ll see the Global Data Source Settings. In

this section, you can select how negative values (-X, X-, or X) and zero values

(Default, With Currency/Unit, As Empty Cell, or Custom) should be displayed. You

can also use a currency conversion method if available.
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� The middle column is the area to place and arrange the dimensions and measures

that should be shown in the columns and rows of the result set. In the Background

Filter section, measures can be added that will be filtered but don’t appear in the

result set.

� On the right side of the window, a Live Preview of the result set is given with the

number of data cells. In the upper-right corner, a Pause Refresh checkbox is avail-

able to suspend the automatic refreshing of the result set. This pause function

comes in handy when you need to make a lot of alterations to the initial view but

you don’t need an updated preview of the result set after each change. When all

changes are done, deselect the checkbox again to refresh the preview of the result

set.

Figure 5.49  Edit Initial View of Data Source

For each measure, you can change the following options by right-clicking the mea-

sure (Figure 5.50):

� Number of decimal places

� The scaling factor

� How the totals are calculated (e.g., Sum, Minimum, Maximum, or Average)

� Specify a predefined dynamic calculation to use like Percentage Contribution

� The sorting order
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Figure 5.50  Context Menu of a Measure

You have serval options to change the presentation of the data. These options corre-

spond to features known from SAP BEx. To change the presentation of a certain

dimension, use the context menu (right-click). You have the following options to

choose from (Figure 5.51):

� Additional attributes to be displayed.

� The active hierarchy and its initial expansion level.

� With the Member for Filtering option, you can set which members of a dimension

are available in the filter. You can choose between the members with posted val-

ues, members that exist in the InfoProvider, or all members in the master data.

� A member to be filtered.

� The filter by input string.

� Member presentation (key, text, key + text, etc.).

� The totals display mode.

Figure 5.51  Context Menu of a Dimension
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Use the Member Display option to define whether the text and/or key value of a

dimension should be shown, its order, and which text type should be used. You can

also choose Filter Members, which allows you to add filters from a list of values. If you

want to make a complex filter, you can choose the Filter by Inputstring option. An

editor will open in which you can enter a filter expression. For example, if you want

the product numbers 0001 through 0005, product number 0008, and all above 0010

in your selection, you can type this filter into the editor: “[0001;0005],0008,[

>0010]”. To remove all filters, use Select All Members.

The Totals Display option determines whether a totals column or row should be

shown for the dimension. You can choose among Show Totals, Hide Totals, and Hide

Totals If Only One Member.

Finally, the Members in Result Set option defines whether all available members in

the master data should be shown or only those members for which values can be

posted.

The context menu of a component has the option to hide a component (Figure 5.52).

This hiding feature is an important feature for developers. Applications that consist

of a large number of components that are nested within each other and form multi-

ple interface layers can quickly lead to an overcrowded Layout Editor. As a result, a

developer can find managing the application difficult. With the Hide feature, the

selected component or components can be hidden from the Layout Editor. When a

component is hidden, the Hide option is replaced with the Show option, which can be

used to reveal the component again. The Hide option has no effect on the application

during execution.

Figure 5.52  Context Menu for Components
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When you select two or more components, the Arrange command is added to the

context menu, providing the commands for alignment. When you select three or

more components, the Distribute commands are available (see Figure 5.53).

Figure 5.53  Arrange Commands in the Context Menu for Components

You can add new items to the application from the context menus of the Data Sour-

ces, Planning Objects, Layout, and Technical Components folders. From the context

menu of the Global variables folder, you can create new global variables. Compo-

nents from the first three folders can also be copied and pasted. In addition, the con-

text menu for the Layout folder has the option Show All Hidden Components to undo

all the Hide settings on the hidden components in one click.

5.3.4    Properties Tab

The Properties tab contains all the settings that can be edited for a selected item, such

as a data source; a component (either layout components, planning objects, or tech-

nical components); or the application itself. When multiple items are selected, only

those properties that are common to all selected items are shown.

In the remainder of this section, we’ll provide a short overview of the properties

available in the various Properties tabs in SAP Lumira, designer edition. In Chapter 7,

we’ll discuss in detail the item-specific properties for all available components.

The Properties tab of a data source consists of four areas (Figure 5.54):

� General 

The data source name and type.

� Data Binding 

Loading settings, source information about the data source, and a Processing

Group that can be assigned to a data source.
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� Display 

Description of the data source shown when the application asks for a prompt

value. When the text field isn’t filled, the data source alias (Name) is used instead.

� Events 

A script is triggered when the result set changes.

Figure 5.54  Properties Tab of the Data Source

The Properties tab of a component can consist—depending on the type of selected

component—of the following areas (Figure 5.55):

� General 

Name and type of component, plus a visibility setting.

� Data Binding 

The data source assigned for this component.

� Optimization for Low Data Volume 

Settings to improve usability.

� User Interactivity 

Various user interaction settings, such as single or multiple data selection and

enabling or disabling the context menu.

� Display 

Formatting and display features.

� Planning 

Settings for planning applications.
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� Events 

Options to create interactivity on this component.

� Layout 

Size and positioning options.

Figure 5.55  Properties Tab of the Crosstab Component

Finally, the Properties tab for the application consists of the following sections

(Figure 5.56):

� General 

Name, location, and application file information.

� Scheduling 

You can add a script that will be triggered when the application is scheduled.



5 The Integrated Development Environment

170

� Behavior 

The number of navigation steps the application needs to remember to allow the

user to undo actions.

� Display 

Formatting and display options.

� Prompts 

Setting to display prompts when starting the application.

� Planning 

Settings related to IP connections and models.

� Scripting 

Definition of global variables.

� Events 

Scripts that have to run when the application starts.

Figure 5.56  Properties Tab of the Application
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5.3.5    Additional Properties Tab

The Additional Properties tab is an extension of the Properties tab but is only avail-

able for a limited number of components such as the scorecard component. With the

scorecard component, you can use the regular properties to position the component

on the canvas, and you’ll use the additional properties (Figure 5.57) to configure the

scorecard.

Figure 5.57  Additional Properties

5.3.6    Error Log Tab

All SAP Lumira, designer edition system and application errors are displayed in the

Error Log tab (Figure 5.58). In addition, messages are displayed when script validation

methods are used in scripts. If you double-click an error, more details about the event

are given in a popup window.

Figure 5.58  Error Log Tab
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5.3.7    Script Problems Tab

The Script Problems tab displays script errors encountered during script validation

(Figure 5.59). This tab is only updated when you open and save an application, so a

problem can remain in the Script Problems tab even after the problem has been fixed.

Double-clicking a problem opens the Script Editor of the component concerned.

Figure 5.59  Script Problems Tab

5.4    Summary

In this chapter, we provided a detailed look at the SAP Lumira, designer edition appli-

cation, with the goal of getting more familiar with its IDE. We discussed all the avail-

able menu options in detail, from creating a new SAP Lumira, designer edition

document and application to checking the SAP Lumira, designer edition software

version in the About menu. You also learned that some of the most important com-

mands are incorporated in the toolbar.

From there, we went through the Layout Editor and all the tabs in SAP Lumira,

designer edition: Documents, Components, Outline, Properties, Additional Proper-

ties, Error Log, Search Results, and Script Problems. We also discussed the menu items

in the Help menu.

In the next chapter, you’ll put this knowledge to use in the application design

process.
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